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Introduction

The Brother mobile printers model PJ-623 and PJ-663 (with Bluetooth) are compatible with many Windows®

and Macintosh® software applications, printing a full letter or legal size document almost anywhere you need
to work. The printers are also compatible with many mobile devices, printing with text or from a custom
printing application. To make this development easier, the printers come with P-touch Editor, a full featured
document design and layout software application that helps you create a custom looking form or template
which can be downloaded and saved in the printer nonvolatile memory. Once saved, you simply send text
data strings to populate the data fields in the form or template and then print out the entire document.

This guide will show you how easy it is to use P-touch Editor and other Brother software applications to print
from using text data.

Important Notice

B The contents of this document and the specifications of this product are subject to change without notice.

B Brother reserves the right to make changes without notice in the specifications and materials contained
herein and shall not be responsible for any damages (including consequential) caused by reliance on the
materials presented, including but not limited to typographical and other errors relating to the publications.

B Screen images in this document may differ depending on your computer's operating system and your
product model.

B Before using the printer, be sure to read all documents included with the printer for information about safety
and proper operation.
Symbols used in this document

The following symbols are used throughout this document.

0 This symbol indicates information or directions that should be followed. Ignoring them may result in
damage, or failed operations.

This symbol indicates notes that provide information or directions that can help you better understand
~] and use the product more efficiently.

About this document

This document (PDF) is included on the CD-ROM.

K// Note

If using Adobe® Reader® to view this document on a computer, the cursor changes to f,\ﬂfr. when the cursor
is placed on a link. Click the link to open the corresponding page. For information about using

Adobe® Reader®, see the help file included with Adobe® Reader®.
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How to install/uninstall P-touch® Editor
Software

P-touch Editor allows you to create templates with various kinds of designs.
Refer to the P-touch Editor help file for template design samples and details on creating, printing, and saving
your templates.

To download the latest driver and software, please visit the Brother Solutions Center website:
http://solutions.brother.com

Installing P-touch Editor Software

0 Insert the CD-ROM into your computer’'s CD-ROM drive.

» Download Windows Mobile printing software

Installation language
[English

L] PoclceT_J=T

(=) 2010 Brother Industries, Ltd. Al Rights Reserved. LE3786001

9 Click [PC (Windows) software], and then click [P-touch Editor 5.0].
0 Follow the on-screen instructions to install the software.

0 Click [Finish] to close the installation screen.

Certain functions cannot be used if the printer driver is not installed.
0 For details about installing the printer driver, refer to the Quick Setup Guide.
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How to install/uninstall P-touch® Editor Software

Uninstalling P-touch Editor Software

@ For Windows® Xxp:
From [Control Panel], go to [Add or Remove Programs].
The [Add or Remove Programs] dialog box appears.

For Windows Vista® / Windows® 7:
From [Control Panel], go to [Programs] and open [Programs and Features].
The [Uninstall or change a program] dialog box appears.

Choose [Brother P-touch Editor 5.0], and click [Remove] (XP) / [Uninstall]
(Windows Vista® / Windows® 7).

@ click [OK].
The uninstall operation starts. After the software is removed from your computer, the
[Maintenance Complete] dialog box appears.

0 Close the [Add or Remove Programs] (XP) / [Programs and Features]
(Windows Vista® / Windows® 7) dialog box.
P-touch Editor / P-touch Update Software has been uninstalled.
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How to use P-touch Editor

The following explanations and procedures depict Windows Vista®, and may vary depending on your
computer’s operating system. In the screen shots, “XX-XXXX” is displayed to represent the printer model

number.

Using P-touch Editor

Starting P-touch Editor

0 Click the start menu -[All Programs]-[Brother P-touch]-[P-touch Editor 5.0].

& Windows Update
Accessories

Brother P-touch

@ P-touch Editor 5.0 (Snap mode)

[ P-touch Editor 5.0 Help

@ P-touch Editor 5.0

. P-touch Tools

aaaaa

When P-touch Editor starts, the [New/Open] dialog box is displayed. This dialog box allows you to select
whether you want to create a new template or open an existing template.

Note

* You can also start P-touch Editor using shortcuts, if you selected to create shortcuts during installation.
» Shortcut icon on the desktop: double-click to start P-touch Editor
» Shortcut icon in the Quick Launch bar: click to start P-touch Editor

» To change how P-touch Editor functions when it starts, click [Tools]-[Options] in the P-touch Editor menu
bar to display the [Options] dialog box. In the [General] tab, select the desired setting in the [Operations]
list box under the [Startup Settings]. Normally, select [Display New/Open Dialog Box].

Download from Www.Somanuals.com. All Manuals Search And Download.



How to use P-touch Editor

9 Select an option in the [New/Open] dialog box and click [OK].

New/Open [z

M Select Printer M Open (B Open File | B8 View History |
Brother Y4CX000(

M Create a New Layout

M Tape size

Letter - ]

AT

A
I

Horizontal Text Vertical Text

|£| Check for Updates
@  Help-HowTo ™ Do Mot Display This Dialog Box at Startup

oK | Cancel

B The printer and media size can be selected in this dialog box.

m Click [Open File] to open the [Open] dialog box, where you can select and open a previously saved
template.

B Click [View History] to open the [History] dialog box, where you can select and open recently saved
templates.

B Click [New] to select the desired orientation (vertical or horizontal) and create a new template.

B Click [Help - How To] to view the P-touch Editor help file.
The help file shows you step-by-step how to create a template.

B Click [Check for Updates] to look for a newer version of P-touch Editor online. If a newer version is
available, the computer’s web browser will open the Brother Solutions Center website, where you can
download the latest version.
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How to use P-touch Editor

Operation modes

P-touch Editor has three different operation modes: [Express] mode, [Professional] mode, and [Snap]
mode. You can easily switch between modes by using mode selection buttons.

B [Express] mode

This mode allows you to quickly and easily create templates that include text and images.
The [Express] mode screen is explained below.

 Vertical i Text m| ]
Label List oo ¥ 2 BB

Date [ Ttle [Body [Code | Memo1 [Memo2 [Vemo3 [Nemoé | Memo5 | Memo§

Brother XX-XXXX_ v @ [0z =] @

1 Menu bar

Provides access to all available commands, which are grouped under each menu title ([File], [Edit],
[View], and [Insert], etc.) according to their functions.

2 Command bar

Provides access to frequently used commands, such as [New/Open], [Paper], [Text], [Frame],
[Image], etc.

3 Draw/Edit toolbar
Provides tools for selecting objects, entering text, drawing graphics, etc.

4 Property bar
Allows you to edit the properties of text, graphics, etc.
5 Template window
Provides the area where you create and edit your templates.
6 Database window
Displays the content of a database or label list that can be used to add content to your templates.

7 Mode selection buttons
Allows you to switch to another operation mode.

Note

* You can show and hide different toolbars and windows using the commands in the [View] menu.
» For details about using [Express] mode, refer to the P-touch Editor help file.
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How to use P-touch Editor

B [Professional] mode

This mode allows you to create templates using a wide-range of advanced tools and options.
The [Professional] mode screen is explained below.

@ P-touch Editor - [Layout2] = o [
@ Fie_Edt Vi B

e Jnsert_Format Tools Layout _Window _Help

Vi Ir Fe T
SHEHOR H S

T = S| B I U & A &
ppppp B El ¥ = 1B It

B W N

1 Menu bar

Provides access to all available commands, which are grouped under each menu title ([File], [Edit],

[View], and [Insert], etc.) according to their functions.

2 Standard toolbar
Provides access to frequently used commands, such as New Layout, Open, Save, Print, etc.

3 Property palette

Provides access to the Print, Paper, Text, and Layout palettes. Click on the left side of each palette to

show/hide the available properties.

4 Draw/Edit toolbar
Provides tools for selecting objects, entering text, drawing graphics, etc.

5 Template window

Provides the area where you create and edit your templates.
6 Database window

Displays the content of a database or label list that can be used to add content to your templates.
7 Mode selection buttons

Allows you to switch to another operation mode.

8 Side bar

Provides access to different tabs that allow you to insert and format text, bar codes, tables, etc., change

the order of the objects to create a template, or set advanced settings.

Note

* You can show and hide different toolbars and windows using the commands in the [View] menu.
» For details about using [Professional] mode, refer to the P-touch Editor help file.
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How to use P-touch Editor

B [Snap] mode

This mode allows you to capture all or a portion of your computer screen content, print it as an image, and
save it for future use.

0 Click the [Snap] mode selection button. The [Description of Snap mode] dialog box is displayed.

Description of Snap mode (=3

The following functions can be used in Snap mode.

Screen Capture Drag-and-Drop

PetouchElectronic
EFIO We Labeling System
o 7 B
:f Ptouchtxt

o

Print Text function

S g Click the P-touch icon to return to the layout window.

Note

« If you select the [Do Not Display This Dialog Again] check box in the [Description of Snap mode]
dialog box, you switch to [Snap] mode next time without displaying the dialog box.

* You can also start P-touch Editor in [Snap] mode by clicking the start menu -[All Programs]-
[Brother P-touch]-[P-touch Editor 5.0 (Snap mode)].

» For details about using [Snap] mode, refer to the P-touch Editor help file.
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How to use P-touch Editor

Using P-touch Editor Help

Viewing the P-touch Editor help file

This section explains how to use the P-touch Editor help file.

Starting from the start menu
Click the start menu -[All Programs]-[Brother P-touch]-[P-touch Editor 5.0 Help].

& Windows Update Search
. Accessories
Brother P-touch tecent ltems
@ P-touch Editor 5.0 (Snap mode)
2 P-touch Editor 5.0 Help
&) P-touch Editor 5.0
P-touch Tools
Extras and Upgrades
Games
. Maintenance EanEt
Microsoft Office

efault Programs
| Startup Default Programs

Back Help and Suppo

=

Starting from the [New/Open] dialog box
When you start P-touch Editor and the [New/Open] dialog box is displayed, click [Help - How To].

New/Open =
I Select Frinter M Open =] OpenFile | [  ViewHistory |
i
M Create a New Layout
B Tape size [ New "\ [Select by Use |
Letter > r
Harizontal Text Vertical Text

[] Checkfor Updates
1@ ( Help-How To I™ Do Not Display This Dislog Bax at Startup

e
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How to use P-touch Editor

Starting from P-touch Editor

B In [Express] mode or [Professional] mode:
Click the [Help] menu and select [P-touch Editor Help].

[Express] mode

W Syl

[B|1/U|ar
e
CIEIEIC)

s Freesie

 Diection

Az © HormnalText
= Vertcaent

[ase [CIERfIC S (7] (L) [E=[E]

Dt Tie Body [Code [Nem! [emo2 [Vero3 [Wemod [Hemob [Veno&

[Professional] mode

@ B i or et fomat Lo Lot i [EEE]

EECILINED
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m\ B3
o] LEE]

Xhipewe
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B In [Snap] mode:

Place the mouse pointer within the [Snap] mode palette so that the four-way arrow pointer (the “move”
pointer) is displayed, right click and then [P-touch Editor Help].

[Snap] mode

Screen Gapture
Return to Edit Layout

Snap Mode Description...
G"—touch Editor Help F'D

How To

About...

Exit

ﬂ// Note

You can also press the [F1] key to open the P-touch Editor help file.
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How to use P-touch Editor

Printing the P-touch Editor help file

You can print P-touch Editor help file content for later reference.

0 In the [Contents] tab, select the content that you want to print.
@ Click [Print] on the Toolbar.

0 Choose the range of topics to be printed, and click [OK].

Print Topics

You can print the selected topic or all the topics in the
selected heading. What would you like to do?

{+ Print the selected topic
" Print the selected heading and all subtopics

oK | Cancel

0 Specify the [Printer] and click [Print].
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How to use P-touch Transfer Manager &
P-touch Library

P-touch Transfer Manager

This program allows you to transfer templates and other data to the printer and save backups of your data on
the computer.

After P-touch Transfer Manager is used to transfer data to the printer, P-touch Template is used to send text
data to the printer that will be inserted into the template and printed. For details on P-touch Template,
download the P-touch Template manual (English only) from the Brother Solutions Center website:
http://solutions.brother.com

[Select your region/country]- Choose your product. -[Manuals]

P-touch Library

This program allows you to use your computer to manage P-touch templates and other data.
You can use P-touch Library to print templates.

Using P-touch Transfer Manager

Starting P-touch Transfer Manager

Click the start menu -[All Programs]-[Brother P-touch]-[P-touch Tools]-[P-touch Transfer Manager 2.1].
When P-touch Transfer Manager starts, the main window is displayed.

Note

You can also start P-touch Transfer Manager from P-touch Editor.
Click [File]-[Transfer Template].

11

Download from Www.Somanuals.com. All Manuals Search And Download.


http://solutions.brother.com

How to use P-touch Transfer Manager & P-touch Library

Main window

2 All Gontents — P-touch Transfer Manager

File Edit Wiem Tool Help

2 _( 73] & &5 Q FH )(PAH‘M’—Ll >_ 3
Open Somah il Sl

"\ [ Hame | ize | Type [ Date [ Cacation

‘ )

LB Layouts
[# Databases
[# Images
Recycle Bin
*@ Search Results 5
|3 Transfer Manager —
=-8]] PG (Brother XX~ X0
a1 Configwations
] Backups
=8 PG (Brother X6~ 30000
%5 Gonfieuratians
) Backups Ao J
27} Brother XH-XHKK [T contents are selected. N\

For Help. press F1

1 Menu bar

Provides access to various commands, which are grouped under each menu title ([File], [Edit], [View],
[Tool], and [Help]) according to their functions.

2 Toolbar
Provides access to frequently used commands.
3 Printer selector

Allows you to select which printer the data will be transferred to. When you select a printer, only the data
that can be sent to the selected printer are displayed in the data list.

4 Folder list

Displays a list of folders and printers. When you select a folder, the templates in the selected folder are
displayed in the template list.

If you select a printer, the current templates and other data stored in the printer are displayed.
5 Template list

Displays a list of templates in the selected folder.
6 Preview

Displays a preview of the templates in the templates list.

12

Download from Www.Somanuals.com. All Manuals Search And Download.



How to use P-touch Transfer Manager & P-touch Library

Explanations of the Toolbar Icons

Icon Button name Function
= Transfer Transfers templates and other data from the computer to the printer
ECJ (available for USB connection only).
= Backu Retrieves the templates and other data saved in the printer and
=l P saves it on the computer (available for USB connection only).
ﬁ? Open Opens the selected template.
- Allows you to search for templates or other data that are registered
) Search )
B to P-touch Library.
j Display Style Changes the file display style.

Transferring templates or other data from the computer to the printer

Use the following procedure to transfer templates from the computer to the printer.

This feature is only available when the computer and printer are connected via USB.

0 Connect the computer and the printer via USB and turn on the printer.
The printer model name is displayed in the folder view.
If you select a printer in the folder view, the current templates and other data stored in the printer are

displayed.

9 Select the printer that you want to transfer the template or other data to.

‘2006/067/16 203924 G¥Doct
2006/03/24 183956 G¥Docy

470KB  Layout 2006/05/16 203538 G¥D

No confenfs are selected.

13
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How to use P-touch Transfer Manager & P-touch Library

@ Right-click the [Configurations] folder, select [New], and then create a new folder.

& All Gontents — P-touch Transfer Manager,

w =0 5 Q e
G s

ch  Display Style

T e [Tooe Tose oo

e L. 18KB  Layout 2006/05/16 203924  C:¥
00. 6KB  Layout 2006/03/24 183956 ¥

E-VISITORIbI 470KB  Layout 2006/05/16 203538 C:¥Docume

Creates a new folder

In the example above, the folder [Transfer] was created.

0 Drag the template or other data that you want to transfer and place it in the new folder.

You can browse for templates or other data by selecting [All contents] or by selecting one of the
categories under [Filter], such as [Layouts].

When transferring multiple templates or other data, drag all the files that you want to transfer and place
them in the new folder.

Each file is assigned a key number (memory location in the printer) when it is placed in the new folder.

s o =,  Friter
= A E Al Prnters -

Open Seach  Display Style

Name I Sizo [ Type TDate
(8} 4x6inch shippina | 188 Loyout 2006/06/16 203924
I 6KB_ Layout 2006/03/24 183956

e
EVETORE T e Tavou ooyt /15 205

For Help,press F1

14
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How to use P-touch Transfer Manager & P-touch Library

@ To change the key number assigned to an item, right-click the item, select [Key Assign], and then select
the desired key number.

o T
o Doz 1 ———[evsion

Note

+ All data transferred to the printer is assigned a key number.

« If the template or other data transferred to the printer has the same key number as another template
already saved in the printer, the new template will overwrite the old one. You can confirm the templates
key number assignments saved in the printer by backing up the templates or other data (see Backing up
templates or other data saved in the printer on page 17).

« If the printer memory is full, remove one or more templates from the printer nonvolatile memory. (see
Backing up templates or other data saved in the printer on page 17).

@ To change the names of templates or other data that will be transferred, click on the desired item and
enter the new name. The number of characters used for the template names may be limited depending
on the printer model.

15
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How to use P-touch Transfer Manager & P-touch Library

o Select the folder containing the templates or other data that you want to transfer, and then click
[Transfer]. A confirmation message will be display.

& PC (Brother XX-XXXX)¥Configurations¥Transfer, - P~touch Transfer Manager.

dit View Tool Help

o o T
[l wmionss & o

For Help,press F1

Note

* You can also transfer individual items to the printer without adding them to a folder. Select the template or
other data that you want to transfer, and then click [Transfer].

* Multiple items and folders can be selected and transferred in one operation.

0 click [0K].

P-touch Transfer Manager

' Files on the computer will be sent ko the printer,
L3 Ok to continue?

Zancel |

The selected templates, folders or other data are transferred to the printer.

16
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How to use P-touch Transfer Manager & P-touch Library

Backing up templates or other data saved in the printer

Use the following procedure to retrieve the templates or other data saved in the printer and save it on the
computer.

B This feature is only available when the computer and printer are connected via USB.

0 B Backed up templates or other data cannot be edited on the computer.

to be transferred to another printer model.

B Depending on the printer model, templates or other data backed up from one printer model may not be able

Connect the computer and the printer via USB and turn on the printer.

The printer model name is displayed in the folder view.

If you select a printer in the folder view, the current templates and other data stored in the printer are
displayed.

Select the printer to back up from, and then click [Backup].
A confirmation message is displayed.

P-touch Transfer Manager

L] Printer data will be backed up onto the computer,
L] QK to conkinue?

Zancel |

Click [OK].

A new folder is created under the printer in the folder view. The folder name is based on the date and
time of the backup. All of the printer's templates and other data are transferred to the new folder and
saved on the computer.

& PG (Brother QL- 1060N)¥Backups¥2006/05/16 21:48:11 — P—touc h Transfer Manager

2006/06/16 214811 -
e - 2006/06/16 214811 -

No confents are selected. ]
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How to use P-touch Transfer Manager & P-touch Library

Deleting all data saved in the printer

Use the following procedure to delete all templates or other data that are saved in the printer.

0 This feature is only available when the computer and printer are connected via USB.

0 Connect the computer and the printer via USB and turn on the printer.
The printer model name is displayed in the folder view.

9 Right-click the printer, and then select [All Delete].

Search Display Style

Transter Name | S [Tooe [ose ey ssien Tarme
5 INVOICES 109KB Template 2008/05/17 0821 1 -
5 VBITOR 4BKE Template 2006/05/170816 2

Multple confents are selected.

A confirmation message is displayed.

P-touch Transfer Manager

] &l data will be deleted From the printer,
. QF ko continue?

Cancel |

@ ciick [OKI.
All templates and other data saved in the printer are deleted.
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How to use P-touch Transfer Manager & P-touch Library

Using P-touch Library

Starting P-touch Library

Click the start menu -[All Programs]-[Brother P-touch]-[P-touch Tools]-[P-touch Library 2.1].
When P-touch Library starts, the main window is displayed.

Main window

45 Al Contents - P-touch Library =2 Eom 5|
1—(Fle Edit View Tool Help
Q)
%
Search
\
/€Y Search Results
—}
3 f—
A
o contents are selected. m
— 5
\ J
For Help, press F1 NUM
1 Menu bar

Provides access to all available commands, which are grouped under each menu title ([File], [Edit],
[View], [Tool], and [Help]) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Folder list

Displays a list of folders. When you select a folder, the templates or other data in the selected folder is
displayed in the templates list.

4 Templates list
Displays a list of the templates or other data in the selected folder.

5 Preview
Displays a preview of the templates or other data selected in the templates list.

19
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How to use P-touch Transfer Manager & P-touch Library

Explanations of the Toolbar Icons

Icon Button name Function

|3 Open Opens the selected template.

5) Print Prints the selected template.
; Allows you to search for templates or other data that are registered
) Search )
B to P-touch Library.

j Display Style Changes the file display style.

Opening and editing templates

Select the template you want to open or edit, and then click [Open].

2 All Contents - P-touch Library ==

File Edit View Tool Help

o B
&
J

|

Display Style

For Help, press F1 NUM

The program that is associated with the template will be started and you can edit the template.

Note

The program that starts depends on the type of file that is selected. For example, if you select a P-touch
template, P-touch Editor starts.

20
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How to use P-touch Transfer Manager & P-touch Library

Printing templates

Select the template that you want to print and then click [Print].

[=lieREs]

& All Contents - P-touch Library
File Edit View Tool Help

E/? 52 Q =R

Search Display Style

[ P-touch Library
All Contents
cle Bin

No contents are selected.

For Help, press F1

The template is printed using the connected printer.

Searching for templates or other data

You can search for templates or other data registered to P-touch Library.

0 Click [Search].

The [Search] dialog box is displayed.

2 All Contents - P-touch Library =3 ol )
File Edit View Tool Help
3 pn =
o = ( = .
— Q. =
e Search Display Style
= P-touch Library
[All Contents
Recycle Bin —
: Search =]
2 Search Results s =
Mutiple Parameters & o C o
Hree ] [comos 5]
e o g | |
I Sie from [0 = e
To 0 = e
™ pate From 6/15/2007 -
To of1s/m07 T
: Close
For Help, press FL NUM
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How to use P-touch Transfer Manager & P-touch Library

9 Specify the search criteria.
The following search criteria are available.

Settings

Details

Multiple Parameters

Determines how the program searches when multiple criteria are specified. If you select
[AND], the program searches for files that satisfy all of the criteria.
If you select [OR], the program searches for files that satisfy any of the criteria.

Name Allows you to search for a template or other data by specifying the file name.
Type Allows you to search for a template or other data by specifying the file type.
Size Allows you to search for a template or other data by specifying the file size.
Date Allows you to search for a template or other data by specifying the file date.

0 Click [Begin Search)].
The search begins.

& Al Contents - P-touch Library

(= [ = )

File Edit View Tool Help

Display Style

For Help, press FL

e I

seel pote tocstion

@ #xGinch shipping L. 18KB

2006/05/16 20:39:24 Layaut

From
Brother Japan
100x150mm
Samele Labels
19801226

To

Brother USA
£:Binch
Sample Lakels

BROTHER INTL
CORP

M

i |

0 Close the [Search] dialog box.

The search results can be confirmed by clicking [Search Results] in the folder view.

Note

You can register templates or other data to P-touch Library by dragging and dropping the files to the
[All contents] folder or to the folder list. You can also configure P-touch Editor to register templates to

P-touch Library automatically, using the following procedure.

1 From the P-touch Editor menu, select [Tools]-[Options].

2 In the [Options] dialog box, click [Registration Settings] in the [General] tab.
3 Select the timing for registering templates created with P-touch Editor, and then click [OK].

Download from Www.Somanuals.com. All Manuals Search And Download.

22



Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
http://myh66.com
http://usermanuals.us

http://www.somanuals.com

http://www.4manuals.cc

http://www.manual-lib.com

http://www.404manual.com

http://www.luxmanual.com

http://aubethermostatmanual.com

Golf course search by state

http://golfingnear.com

Email search by domain

http://emailbydomain.com

Auto manuals search

http://auto.somanuals.com

TV manuals search

http://tv.somanuals.com



http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

	P-TOUCH® EDITOR SOFTWARE USER’S GUIDE PJ-623/PJ-663 Mobile Printer
	Introduction
	Important Notice
	Symbols used in this document
	About this document

	Table of Contents
	1 How to install/uninstall P-touch® Editor Software
	Installing P-touch Editor Software
	Uninstalling P-touch Editor Software

	2 How to use P-touch Editor
	Using P-touch Editor
	Starting P-touch Editor
	Operation modes

	Using P-touch Editor Help
	Viewing the P-touch Editor help file
	Printing the P-touch Editor help file


	3 How to use P-touch Transfer Manager & P-touch Library
	Using P-touch Transfer Manager
	Starting P-touch Transfer Manager
	Transferring templates or other data from the computer to the printer
	Backing up templates or other data saved in the printer
	Deleting all data saved in the printer

	Using P-touch Library
	Starting P-touch Library
	Opening and editing templates
	Printing templates
	Searching for templates or other data


	brother US ENG


